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ВСТУП 

 

Будь-яке підприємство зіштовхується з проблемою автоматизації роботи 

окремих співробітників і цілих підрозділів. Перша проблема при цьому – як 

вибрати відповідні програмні продукти. Бажані властивості інформаційної 

системи сильно залежать від розмірів підприємства й специфіки його бізнесу, 

але є й Універсальні вимоги. 

Звичайно, будь-яке підприємство має потребу в інструментах для роботи 

з текстами (створення, редагування, оформлення документів), а також для 

обробки даних (електронні таблиці, засоби аналізу й планування, СУБД). Але 

цього, як правило, недостатньо. Адже з документами працюють різні люди, Я 

документи часто складаються з різних частин, включаючи тексти, числа, 

таблиці, графіки, діаграми, малюнки, навіть звук або відео. 

Сьогодні все це можливо завдяки створеному компанією Microsoft 

сімейству програм для підтримки офісної діяльності Microsoft Office. 

Комплект програмних продуктів Microsoft Office включає кілька 

додатків, що утворюють єдине середовище для обробки будь-якої інформації. 

До складуй Microsoft Office входить потужний текстовий процесор Microsoft 

Word, електронні таблиці Microsoft Excel та ін. 

Microsoft Word – потужний текстовий редактор, що дозволяє швидко 

створити документ будь-якої складності з розрізнених заміток і довести до 

досконалості інформаційний бюлетень або брошуру. 

Це вже загальновизнано – редактор Word фірми Microsoft є сьогодні 

найпопулярнішою у світі програмою. Word начинений «швидкими» 

командами і найсучаснішими засобами, такими як вбудована програма 

перевірки правопису і словник синонімів, що допомагають вам грамотно 

складати документи, і готовій шаблони, які дозволяють вам об'єднувати 
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окремі замітки, листи, рахунки й брошури без надмірних зусиль. 

Microsoft Excel робить з числами те ж саме, що Word з іменниками й 

дієсловами. Кожен, хто працює з цифрами, відчує себе в середовищі Excel як 

риба у воді. Користуйтеся програмою Excel для складання бюджетів і 

фінансових звітів, перетворення сухих цифр у наочні діаграми і графіки, 

проведення аналізу на зразок «А що буде, якщо?» практично з будь-якого 

питання, а також для сортування довгих списків за лічені секунди. 

За допомогою таблиць Excel можна вдруковувати числа, рядок за 

рядком і стовпчик за стовпчиком, будучи цілком упевненим у тому, що Excel 

правильно додасть, відніме, помножить, розділить і взагалі зробить із ними 

те, що треба. 

Текст лекцій розрахований на 8 занять, в кожному з яких висвітлюються 

конкретні питання щодо роботи з Microsoft Word або Microsoft Excel, що 

вказані на початку кожної лекції. Лекційний матеріал має необхідні 

ілюстрації, що спрощють сприйняття інформації студентом. Для зручності 

студентів при підготовці до поточного контролю, надані питання для 

самопідготовки. 
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Лекція 1 

ОБРОБКА ТЕКСТІВ РЕДАКТОРОМ MS WORD 

 

1. Терміни й визначення 

2. Поняття тексту і його обробка 

3. Правила підготовки сучасних документів  

 

Серед основних тем, розглянутих звичайно при вивченні редактора MS 

Word 2003, представлені наступні [5, 6, 7]: 

 Технологія підготовки текстових документів.  

 Програма MS Word 2003 (її призначення, версії, інтерфейс, меню, 

панель завдань і панелі інструментів, сервісні можливості, робота з її 

файлами й із системою допомоги). Робоче вікно. Параметри й настроювання. 

Орієнтація на Інтернет-технології. 

 Основні прийоми роботи з документами (створення, збереження, 

закриття, властивості, статистика, стандарти). Режими перегляду документів. 

Захист документів. Використання стилів і шаблонів. 

 Редагування документів (уведення тексту, його копіювання, 

переміщення, пошук і заміна, добір синонімів, переклад тексту, перевірка 

граматики, уведення спеціальних символів).  

 Зміна зовнішнього вигляду документів (методи роботи з абзацом, 

установка табуляції, форматування тексту, шрифти, використання анімації, 

списків і стилів, нумерація сторінок).  

 Вистава тексту в таблицях (вистава інформації у вигляді таблиці, 

форматування таблиці, виконання розрахунків за допомогою таблиць). 

Вистава тексту в колонках і рамках.  

 Зв’язування й впровадження об’єктів (менеджер і колекція картинок, 

звукові й відеокліпи). Робота з Xml–Документами. 

 Робота із графікою (панель рисування, автофігури, діаграми, ефекти 

Wordart). 

 Робота з формулами (математичний редактор). 
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1. Терміни й визначення 

Документ – матеріальний об’єкт, що містить у зафіксованому виді 

інформацію, оформлену встановленим порядком, що має відповідно до 

чинного законодавства правове значення. 

Документ – інформаційне повідомлення в паперовій, звуковій або 

електронній формі, оформлене за певними правилами (стандартам), завірене 

у встановленому порядку.  

Документ – кожний самостійний файл, створений у редакторі Word, що 

одержав при збереженні унікальне ім’я, за допомогою якого він буде 

використовуватися надалі.  

Документ – файл, створений у редакторі Word, має всі атрибути 

документа. 

Початковий документ – документ, у якім був створений зв’язаний або 

впроваджений об’єкт.  

Кінцевий документ – документ, у який вставляється впакований об’єкт, 

зв’язаний або впроваджений об’єкт. Для впровадженого об’єкта такий 

документ іноді називають документом-контейнером.  

Складений документ – це документ, у якім зв’язані між собою 

фрагменти мають різні типи й створювалися в різних додатках або 

програмах. 

Редактор формул – редактор MS Equation 3.0, вбудований в Word. 

Сторінка – документ, постачений унікальною адресою, яка можна 

відкрити й подивитися за допомогою програми перегляду. 

Джерело паперу – пристосування, таке як верхній лоток для паперу або 

податчик конвертів, що подає папір у принтер.  

Дескриптор – одне слово або словосполучення, що заміняє в певному 

контексті безліч зв’язаних за змістом слів і словосполучень, що виражають ту 

саму думку.  

Тезаурус – нормативний словник, у якім поняття визначається логічно 

впорядкованим безліччю синонімічних або близьких за значенням слів.  

Текст – послідовність символів, слів і пропозицій, побудована 

відповідно до законів мови. Головна особливість тексту: текст завжди 

лінійний, послідовно викладає події і явища. Усередині вільного тексту може 

бути інформація у вигляді малюнків, діаграм і формул.  
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Графічні об’єкти – це малюнки, фотографії, діаграми й т.п. 

Таблиця в документі – це табличне завдання даних у документі. 

Вставка об’єктів – це спосіб впровадження в документ Word об’єктів, 

створених в іншім інструментальнім середовищі. 

Стиль – набір різних форматів, що визначають вид фрагмента 

документа при застосуванні даного стилю. 

Форматування – спосіб приведення документа або його фрагмента до 

певного виду. Для цього використовуються певні приймання форматування й 

інструменти. 

Шаблон – стандартний бланк, використовуваний для створення інших 

документів. 

Документообіг – система створення, інтерпретації, передачі, приймання 

й архівування документів, а також контролю над їхнім виконанням і захисту 

від несанкціонованого доступу.  

Система діловодства й документообігу електронних документів – 

комплексне застосування комп’ютерів в управлінській діяльності для обігу, 

зберігання, пошуку й відображення інформації, що дозволяє звести до 

мінімуму або виключити повністю застосування паперових носіїв інформації.  

Електронний документ – документ в електронній формі: закодоване й 

передане в інформаційну систему електронне повідомлення, усі реквізити 

якого завірені й оформлені відповідно до нормативних вимог.  

Електронний документообіг – система документообігу, у якій 

звертаються електронні документи в стандартизованій формі й на основі 

прийнятих у системі регламентів. 

Офіс – місце, де відбуваються ділові операції персоналом підприємства, 

убраною довірою й владою ухвалювати управлінські розв’язки.  

Електронний офіс – офіс, у якому є автоматизовані робочі місця 

співробітників, що дозволяє робити всі ділові операції на основі безпаперової 

технології ( в електронній формі). 

 

2. Поняття тексту і його обробка 

Текст – це надрукована, написана або зображена на екрані дисплея 

послідовність букв. Тобто текст – це інформаційна частина повідомлення. 
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Обробка тексту – це його редагування (підготовка, вставка, заміна, 

видалення, збереження) і форматування ( по розмірах аркуша й відступам, 

по жирності, курсиві, підкресленні, по типу використовуваних шрифтів, по 

центруванню, вирівнюванні ліворуч, праворуч, а також використання 

колонтитулів, вставок, нумерації сторінок, ефектів і т.д.). 

Редактор текстів – це програма, що забезпечує редагування текстів 

документів відповідно до команд, що задаються. Він дозволяє – створити 

новий файл (відкрити існуючий), працювати із символом, словом, рядком, 

блоком тексту (уведення із клавіатури, вставка, видалення, вирізання, 

копіювання, переміщення, робота через буфер обміну або через скарбничку), 

зберігати файли в різних форматах з тим же або з новим іменем, друкувати 

документи на принтері. 

 

3. Правила підготовки сучасних документів  

Це питання діловодства (починаючи з полів сторінки документа), 

шаблони документів (бланки, листи ...), види оформлення (стиль, шрифт, 

розмір, форматування), приймання роботи з текстом (заміни, виноски, 

списки, орфографія, тезаурус), використання колонтитулів (верхній і нижній, 

нумерація сторінок, підписи) і  макрокоманд (їх створення, зберігання й 

застосування). 

Для більшості користувачів підготовка текстів і документів починається 

з питання “Як правильно їх готовити?”. При цьому початкові правила 

звучать так: 

 Не перевантажуйте сторінку документа. 

 Проявляйте послідовність у використанні шрифтів і не  

використовуйте більш трьох шрифтів в одному тексті. 

 Не збільшуйте без необхідності інтервал між рядками. 

 Зменшуйте інтервал між рядками в заголовку, якщо там усі букви 

заголовні. 

 Не переносіть слова в заголовку. 

 Не вирівнюйте ширину рядка в заголовках (або в рядках, набраних 

великим шрифтом). 
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 При виводі на лазерний принтер не друкуйте текст на темному тлі 

або поверх ілюстрацій. 

 Використовуйте спецефекти тільки в підходящіх для цього випадках. 

 Натискайте на клавішу Enter тільки тоді, коли Ви прагнете створити 

або почати новий абзац у тексті або коли потрібно вставити порожній рядок. 

Не потрібно використовувати цю клавішу наприкінці кожного рядка (Word 

сам переносить слова на новий рядок при досягненні границі області печаті).  

 Використовуйте для форматування тексту й додання документу 

гарного зовнішнього вигляду потужний засіб – характеристики й властивості 

абзацу. 

 Не робіть у документі більш одного пробілу підряд. Замість цього 

використовуйте табулятор. Для установки різних характеристик паперу в 

одному документі створюйте розділи документа через механізм “розривів” і 

т.д. 
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Лекція 2 

ОБРОБКА ТЕКСТІВ РЕДАКТОРОМ MS WORD 

 

1. Текстовий редактор MS Word 2003 

2. Інтерфейс редактора 

3. Редагування тексту й сервісні операції 

 

1. Текстовий редактор MS Word 2003 

Текстовий редактор MS Word 2003 – це програма, призначена для 

створення, перегляду, редагування й форматування документів.  

Цей редактор залишається самим популярним у світі текстовим 

редактором. Він має всі сучасні компоненти й режими для оформлення 

документів. Дозволяє застосовувати різні шрифти, вставляти в документ 

електронні таблиці, діаграми, складні математичні формули, графічні 

ілюстрації й звукові коментарі, забезпечує перевірку орфографії, 

орієнтований на технології Інтернет. По своїх можливостях MS Word 2003 

наближається до настільних видавничих систем. Забезпечена (майже в 

повному обсязі) сумісність версій MS Word 7/97/2000/2003. Редактор працює 

як самостійна програма (пакет) або в складі офісної системи комплектів MS 

Office 2003 під керуванням ОС Windows 2000/ХР. 

Для установки й роботи MS Word 2003 потрібно ПК із процесором 

“Пентиум” і із установленої ОС Windows 2000/ХР, не менш 200 Мб вільного 

місця на вінчестері. Дистрибутив поставляється на CD-ROM. Установка 

проводиться по одому із чотирьох варіантів – мінімальна, типова (має 

більшість функцій), повна, вибіркова (тут користувач сам визначає що йому 

потрібно для подальшої роботи – графічна бібліотека, вставка діаграм, 

редактор формул і т.д.).  

Усі настроювання MS Word 2003 після його установки за 

замовчуванням зберігаються у файлі Normal.dot. Створювані файли 

документів мають за замовчуванням розширення .doc. 

 

2.2 Інтерфейс редактора 

– це головне вікно програми MS Word 2003, показане на рис. 1, яке 

можна розділити на п’ять основних областей: 
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Рисунок 1 – Інтерфейс програми Word 2003 

 

 Рядок заголовка містить заголовок, піктограму системного меню й 

кнопки керування вікном. 

 Рядок меню містить команди основного (функціонального) меню. 

Усі команди є ієрархічними. Це означає, що при виборі однієї з таких команд 

на екрані з’являється її меню, що випадає. 

 Панель стандартних інструментів (або піктографічне меню). Воно 

включається через меню. Далі здійснюється вибір (стандартна, 

форматування, рисування, бази даних і т.д.) і їхній вид (кнопки кольорові або 

сірі, більші або звичайного розміру, підказки на кнопці потрібні чи ні). 

Кожну з панелей можна модифікувати (переробити). Так, щоб вилучити 

кнопку або піктограму треба нажати ALT і мишкою перемістити кнопку в 

робочу область вікна. Можна пересунути кнопку (ALT+мишкою кнопку в 

потрібне місце на цій або іншій панелі інструментів). Можна скопіювати 

кнопку (ALT+CTRL+мишкою кнопку в потрібне місце на цій або іншій 

панелі інструментів). 

 Піктограми стандартної панелі, звичайно, наступні: відкрити 

новий документ по стандартному шаблонові з Normal.dot; відкрити існуючий 

документ; зберегти файл або шаблон; друкувати документ; показати 
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документ перед печаткою; перевірити правопис документа або фрагмента; 

вирізати виділений фрагмент у буфер обміну (ножиці); копіювати фрагмент у 

буфер обміну; вставити фрагмент із буфера обміну; копіювати формат (від 

виділеного фрагмента на весь документ); скасування останньої операції (або 

скасування будь-якої операції зі списку); повторно виконати останню 

операцію (або будь-яку операцію зі списку); встави таблиц; встави аркуш 

Excel; розташува текст колонок; запусти графічн редактор; показа символів, 

що не друкуються; становити степінь показа документа в процентах; 

використовувати справку (“Мастер підсказок” або контекстно-зазалежну 

допомогу. 

 Панель форматування звичайно містить наступні "інструменти" і 

піктограми – список стилів активного документа; список шрифтів і розмір 

шрифту в пунктах; тип шрифту (жирний, курсив, з підкресленням); вирівняти 

(ліворуч, по центру, праворуч, по ширині сторінки); нумерація маркованих 

абзаців; вид обрамлення й тла, колір символів у документі. 

 Рядок стану розташований у нижній частині головного вікна. Вона 

містить індикатори режиму робота (чорний колір – включений режим, сірий 

(виключений) і відображає наступну інформацію про поточний документ: 

 Стр. 4  курсор на 4-й сторінці; 

 Разд. 2  на 2-м розділі; 

 4/10    на 4 сторінці з 10; 

 на 6 см  на 6 см курсор нижче верхнього краю аркуша ; 

 ст 4   на 4-й рядку; 

 кол 48  на  48-й стовпчику ліворуч; 

 ЗАМ  включений режим вибою (INS); 

 ИСПР  включений режим маркування редагування; 

 КОЛ  включений режим маркування колонок; 

 РАСШ   включений режим розширення маркування. 

 

До інтерфейсу відносяться також лінійки (горизонтальна й 

вертикальна), що дозволяють візуально оцінити поточне положення курсору 

в тексті. Вони включаються через меню й градуюються в сантиметрах. 

Горизонтальна лінійка дозволяє візуально змінювати: відступи абзаців, 
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полючи на сторінці, ширину стовпчиків і стовпців таблиць, установлювати за 

допомогою миші позиції табуляції. А вертикальна лінійка відображається 

уздовж лівого поля сторінки й з її допомогою можна швидко регулювати 

верхні й нижні поля сторінки, а також висоту рядків у таблицях. 

Для навігації в документі використовуються смуги прокручування 

(права й нижня) з маніпуляторами посторінкового листания.  

Мишка. Без неї практично неможлива успішна, швидкісна робота при 

підготовці документів. Через неї реалізуються три команди (клацання, 

подвійне клацання й буксирування). Вид мишки міняється при виконанні 

різних операцій. 

Режим перегляду документа на екрані визначається кнопками, 

розташованими в нижній частині інтерфейсного вікна ліворуч. Робота з 

документом в MS Word 2003 може здійснюватися в одному з наступних 

режимів: звичайний, Web-Документ, розмітка сторінки, структура й режим 

читання. Однак при підготовці документів основним є режим “Розмітка 

сторінки”. Цей режим дозволяє одержати адекватну виставу про сторінку 

документа, і внести потрібні уточнення в текст і форматування. 

Важливими для практичної роботи є можливість відображення 

спеціальних символів і попереднього перегляду документа. Більші 

можливості має MS Word 2003 при підготовці й виконанні друку документів. 

 

3. Редагування тексту й сервісні операції 

Редагування тексту – це внесення яких-небудь змін в існуючий 

документ. Елементарні операції редагування зводяться до вставки або 

видалення символу. Складні операції припускають роботу із фрагментами 

документа, які можуть містити рисунки, таблиці, кадри й інші об’єкти. В MS 

Word 2003 можна переміщати, копіювати й видаляти фрагменти документа.  

Однак перш ніж приступитися до операцій із фрагментами, необхідно 

виділити фрагмент у документі. Для виділення тексту можна 

використовувати мишку або клавіатуру. Наприклад, для виділення слова 

можна встановити курсор мишки на це слово й зробити подвійне клацання. 

Для виділення рядка – установити покажчик мишки напроти виділюваного 

рядка ліворуч від документа й зробити одне клацання. Для виділення абзацу 

– установити покажчик мишки напроти будь-якого рядка виділюваного 
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абзацу ліворуч від документа й зробити подвійне клацання. Щоб виділити 

фрагмент документа довільного розміру можна встановити покажчик мишки 

на початку фрагмента, нажати кнопку миші й, не відпускаючи її, перемістите 

покажчик у кінець фрагмента. Для завершення виділення потрібно 

відпустите кнопку мишки. У якості фрагмента можуть виступати одиничний 

символ, слово, пропозиція, абзац, кілька абзаців. Виділений у документі 

фрагмент можна вилучити, перемістити, копіювати. Для цього можна 

використовувати, наприклад, “швидкі клавіші”. 

Для збереження документа його необхідно записати у файл на 

жорсткий диск, скориставшись відповідною командою. Файлу потрібно дати 

ім’я й визначити папку для зберігання файлу. Можливо автоматичне 

збереження файлу з документом і його захист. 

При роботі з документом MS Word 2003 забезпечує виконання великої 

кількості сервісних операцій. Серед них – пошук і заміна тексту, перевірка 

орфографії (ручна або автоматична), автоформат, уведення виносок і 

спецефектів, робота з кадрами, з колонками, з колонтитулами, із графікою, з 

автофігурами, з таблицями, з формулами, з макрокомандами.  

Серед спеціальних операцій можна відзначити роботу зі скарбничкою 

для переміщення тексту й рисунків. Скарбничка в MS Word 2003 забезпечує 

перенесення декількох об’єктів з різних частин одного або декількох 

документів і вставки їх єдиною групою в інше місце документа. Скарбничка 

накопичує об’єкти у вигляді елементів автотекста, так що їх можна 

використовувати для вставки неодноразово. Для зміни набору об’єктів у 

скарбничці необхідно її попередньо очистити. Алгоритм наступний: 

 Виділите текст або рисунок, який слід помістити в скарбничку, а 

потім натисніть клавіші CTRL+F3.  

 Повторіть цей крок для кожного об’єкта, який слід помістити в 

скарбничку. 

 Встановіть курсор у документі туди, куди слід вставити вміст 

скарбнички.  

 Виконаєте одну з наступних дій: 

А) Для вставки вмісту скарбнички з її одночасним очищенням натисніть 

клавіші CTRL+SHIFT+F3.  
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Б) Для вставки вмісту скарбнички без її очищення, виділите в меню 

Вставка команду Автотекст, а потім – команду Автотекст. У поле Ім’я 

елемента виберіть Скарбничка, а потім натисніть кнопку Вставити. 

Для оформлення документа надзвичайно важливий шаблон. Він 

визначає сукупність параметрів, на підставі яких буде здійснюватися 

форматування документа (накреслення шрифту, величину полів, установки 

табуляторів, вид тексту, колонтитули, стилі (звичайний або користувацький), 

таблиці, рамки, графічні зображення, спеціальні засоби (макроси, кнопки й 

панелі інструментів). Існують шаблони трьох типів: 

 Звичайний – призначений для створення стандартних документів з 

параметрами, прийнятими за замовчуванням. 

 Спеціальні – що входять в комплект поставки MS Word 2003 

(наприклад, листа, факси, і т.д.), а також створені користувачем різноманітні 

користувацькі шаблони. 

 Майстри – в інтерактивному режимі вони проводять користувача 

через усі стадії створення конкретного документа. 

Стиль – це сукупність параметрів форматування в MS Word 2003, що 

має свою назву. Використання стилів дозволяє підвищити ефективність і 

прискорити виконання роботи. Форматування за допомогою стилів зводиться 

до виділення потрібних фрагментів тексту й вибору зі списку необхідного 

стилю для даного фрагмента. Для зручності використання стилі, доступні у 

всіх шаблонах, зведені в бібліотеку стилів, яка доступна через однойменне 

вікно діалогу. 

MS Word 2003 містить кілька десятків вбудованих стилів, а також п’ять 

основних або, як їх ще іноді називають, базових стилів (нормальний, 

заголовок 1, заголовок 2, заголовок 3 і шрифт абзацу за замовчуванням). 

Стилі, використовувані в поточному документі, представлені в списку 

“Стиль” на панелі інструментів “Форматування”. У якості основного стилю, 

установленого за замовчуванням використовується стиль “Нормальний”. Цей 

стиль застосовується для основного тексту будь-якого документа і є основою 

для створення інших стилів.  

Параметри форматування, що входять у поняття стилю абзацу, – це 

шрифт (яким написаний текст абзацу), відступи й інтервали (установлені для 
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даного стилю абзацу), позиції табуляції (установлені в абзаці), обрамлення 

навколо абзацу тексту, мова абзацу, нумерація рядків в абзаці.  

Методика використання стилів зводиться до наступного: 

 Намагайтеся не змінювати стандартні стилі MS Word 2003 (особливо 

у файлі normal.dot). 

 Спочатку створіть стилі, а потім починайте створювати документи.  

 Створіть типові стилі й шаблони для Вашої організації 

(неприпустимо щоб кожний співробітник витрачав час на оформлення 

кожного нового документа). 
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Лекція 3 

ОБРОБКА ТЕКСТІВ РЕДАКТОРОМ MS WORD 

 

1. Впровадження й зв’язування об’єктів 

2. Графічні зображення в документах Word  

 

1. Впровадження й зв’язування об’єктів  

Для об’єднання в одному документі об’єктів різного походження, 

наприклад, щоб вставити в текст графіку, музику, фрагмент електронної 

таблиці і т.д., у додатках Windows широко застосовується технологія OLE 

(Object Link and Embedding) – зв’язок і впровадження об’єктів. Це означає, 

що об’єкт, що міститься в текст, може включатися в нього у двох варіантах:  

• як впроваджений – він стає частиною документа Word. Усі зміни, котрі 

проводяться в джерелі, не будуть відбиватися в документі, наприклад, якщо 

впровадити раніше створений в Pbrush рисунок в Word, потім завантажити 

Pbrush і зробити зміни над рисунком, те ці зміни не відіб’ються на рисунку в 

текстовому документі;  

• як зв’язаний – тут, навпаки, якщо проводяться зміни над рисунком у 

джерелі, те ці зміни відбиваються й на малюнку, поміщеному в текстовий 

документ.  

Розрізняють також терміни технології OLE:  

• клієнт – додаток, що ухвалює об’єкт;  

• сервер – додаток, засобами якого створюється об’єкт.  

Впроваджений або зв’язаний об’єкт можна згодом редагувати засобами 

додатка-сервера. Для цього треба виконати подвійне клацання миші на 

даному об’єкті (Word завантажить додаток-сервер), зробити зміни в об’єкті і 

повернутися в додаток-клієнт.  

Технологія OLE здійснюється двома способами:  

1) через буфер обміну – командою додатка Виправлення\Спеціальна 

вставка ...  

2) командою додатка Вставка\об’єкт....  
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Першим способом можна впровадити (або зв’язати) фрагмент документа 

або впровадити (або зв’язати) весь документ, другим способом – тільки цілий 

документ. Причому в другому випадку можна впроваджувати або зв’язувати 

вже готовий об’єкт, а також створити новий об’єкт у процесі впровадження 

(зв’язування).  

 

Таблиця 1 – Способи впровадження об’єктів 

Через буфер обміну Командою Виправлення\Об’єкт... 

1 2 

Впровадження:  

1) у додатку–сервері виді–

лити об’єкт  

2) занести його в буфер 

обміну  

(Виправлення \Копіювати)  

3) перейти в додаток-клієнт  

4) виконати команду  

Вставка \ Спеціальна 

вставка...  

5) залежно від того, який 

додаток-сервер (наприклад, 

MS Excel, Coreldraw, MS 

Word і т.д.), Word запропонує 

діалогове вікно для вибору 

різних типів впровадження  

Впровадження готового об’єкта:  

1) у додатку-клієнтові виконати команду 

Вставка \ Об’єкт...  

2) у діалоговім вікні, що з’явилося, 

активізувати вкладку Створення з файлу  

3) через кнопку Огляд вибрати 

впроваджуваний об’єкт  

Впровадження об’єкта, створюваного в 

процесі впровадження:  

1) у додатку-клієнтові виконати команду 

Вставка \ Об’єкт...  

2) у діалоговім вікні, що з’явилося, 

активізувати вкладку Створення  

3) вибрати додаток–сервер, створити в 

ньому об’єкт  

4) повернутися в додаток–клієнт 

(клацнути поза границею розмірів 

виділеної області)  
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Продовження таблиці 1 

1 2 

Зв’язування:  

виконати ті ж самі дії, що й при 

впровадженні, тільки в пункті 5 у 

діалоговім вікні необхідно 

активізувати перемикач Зв’язати, 

при цьому можна активізувати ще 

перемикач Значок, який 

виводиться замість зв’язаного 

об’єкта  

Зв’язування:  

виконується аналогічно 

впровадженню готового об’єкта, 

тільки в пункті 2 у діалоговому вікні 

активізувати перемикач Зв’язок з 

файлом, при цьому можна 

активізувати ще перемикач Значок, 

який виводиться замість зв’язаного 

об’єкта  

 

Примітка. У багатьох випадках команда вставки вмісту буфера обміну 

Виправлення\Вставити за замовчуванням впроваджує об’єкт, тобто виконує 

роль одного з варіантів впровадження.  

 

2. Графічні зображення в документах Word  

У текстовому процесорі Word використовуються наступні режими 

роботи із графікою:  

1) вставка (або зв’язок) об’єкта, створеного в деякому графічному 

редакторі (наприклад, Paintbrush, Photoshop і т.д.); найбільше часто 

використовується спосіб впровадження або зв’язки через буфер обміну;  

2) рисування в самому документі, використовуючи панель інструментів 

Рисування;  

3) використання готових рисунків з колекції Clipart, а також його 

редагування; графічний файл або впроваджується в документ Word, або з ним 

установлюється зв’язок.  

 

У документи можна додавати не тільки написи, але і графічні об’єкти. 

Щоб додати рисунок в документ Word, скористайтеся однією з наступних 

команд після вибору команди Insert→Picture (Вставка→Рисунок) (рис. 2). 
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Рисунок 2 – Декілька прикладів різних типів зображень, які Word дозволяє вставляти 

в документ 

 

- Clip Art (Картинки). Додає картинку з колекції Microsoft Office. 

- From File (З файлу). Додає рисунок з графічного файлу, створеного 

іншою програмою, наприклад PaintShop Pro або Adobe Photoshop. 

- From Scanner or Camera (Co сканера або з камери). Дозволяє додати 

цифрову фотографію. 

- AutoShapes (Автофігури). Дозволяє вибирати різні фігури, наприклад 

овал, прямокутник або зірку. 

- WordArt (Об’єкт WordArt). Дозволяє друкувати текст, що 

відформатував різними кольорами і шрифтами. 
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- Organizational Chart (Організаційна діаграма). Дозволяє створити 

стандартну організаційну діаграму, по якій можна легко визначити, хто керує 

роботою, а хто виконує її основну частину. 

- New Drawing (Новий рисунок). Дозволяє створювати рисунки з 

геометричних фігур, ліній або об’єктів WordArt 

- Chart (Діаграма). Дозволяє додавати в документ графіки, кругові 

діаграми і гістограми. 

 

Як помістити рисунок в документ 
У колекцію Microsoft Office входять картинки, за створення яких 

компанія Microsoft заплатила професійним художникам, позбавивши вас від 

необхідності освоювати комп’ютерну графіку. 

Щоб додати малюнок в документ, виконайте наступне. 

1. Підведіть покажчик до тієї частини документа, в якій ви вирішили 

вставити малюнок. 

2. Виберіть команду Insert→PiCture→CMp Art (Вставка→Рисунок1→ 

Картинки). З’явиться область завдань Clip Art (Колекція кліпів). 

3. Клацніть в текстовому полі Search for (Шукати) і введіть опис 

картинки. Вам слід вводити дуже прості описи, наприклад тварини. 

4. Клацніть на кнопці Go (Знайти) або натисніть клавішу <Enter>. У 

області завдань Clip Art (Вставка картинки) з’явиться список картинок, 

відповідних заданому вами критерію (рис. 3). 

5. Клацніть правою кнопкою миші на вподобаному зображенні. У меню, 

що з’явилося, виберіть команду Insert (Вставити). Word вставить вибрану 

картинку в документ. 

6. Клацніть на кнопці закриття, щоб прибрати область завдань Clip Art 

(Вставка картинки) з екрану. 

 

Додавання в документ існуючих графічних файлів 
Якщо у вас є вже створений, скопійований або придбаний графічний 

файл, його можна додати в документ. Щоб додати існуючий графічний файл 

в документ, виконайте наступне. 
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1. Підведіть покажчик миші до того місця документа, в якому необхідно 

вставити графічне зображення. 

2. Виберіть команду Insert→Picture From File (Вставка→Рисунок→З 

файлу). З’явиться діалогове вікно Insert Picture (Додати рисунок). 

3. Клацніть на теці, в якій міститься необхідний графічний файл. 

4. Клацніть на імені файлу, який ви хочете використовувати. Word 

відобразить вибране вами графічне зображення. 

5. Клацніть на кнопці Insert (Вставка). Word вставить вибране 

зображення в документ. Якщо ви хочете, щоб текст обтікав рисунок, 

виконайте дії, описані нижче, в розділі "Обтікання рисунка текстом". 

 

 
Рисунок 3 – Область завдань Вставка картинки дозволяє провести пошук картинок, 

вказавши їх тему 
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Використання в документі засобу WordArt 
WordArt – чудовий спосіб надати документу унікальному зовнішньому 

вигляду завдяки комбінуванню різних кольорів, форм і шрифтів. Щоб додати 

в документ об’єкт WordArt, виконайте наступне. 

1. Підведіть покажчик миші до того місця документа, в якому необхідно 

вставити графічне зображення. 

2. Виберіть команду Insert→Picture→WordArt (Вставка→Рисунок→ 

Объект WordArt). З’явиться діалогове вікно WordArt Gallery (Колекція 

WordArt) (рис. 4). 

3. Виберіть тип об’єкту, який хочете використовувати, і клацніть на 

кнопці ОК. З’явиться діалогове вікно Edit WordArt Text (Зміна тексту 

WordArt) (рис. 5). 

 

 

 

Рисунок 4 – В діалоговому вікні Колекція WordArt представлені різні стилі, які можна 

застосовувати до тексту 
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Рисунок 5 – Діалогове вікно Заміна тексту WordArt 

 

4. Введіть необхідний текст. Вам також надається можливість змінити 

шрифт, його розмір і зображення. 

5. Клацніть на кнопці ОК. 

Після того, як зображення буде вставлено в документ, вам може 

знадобитися змінити параметри його "взаємодії" з навколишнім текстом, а 

також перемістити рисунок на нове місце або видалити його. 

 

Обтікання рисунка текстом 
 Для визначення стилю обтікання рисунка текстом виконаєте наступні 

дії: 

1. Клацніть правою кнопкою миші на рисунку, який повинен обтікати 

текст. З’явиться контекстне меню. 

 2. Виберіть команду Format→Picture (Формат→Рисунок). З’явиться 

діалогове вікно Format Picture (Формат). 

 3. Перейдіть на вкладку Layout (Положення). Word відобразить декілька 

різних способів обтікання тексту (рис. 6). 
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Рисунок 6 – Діалогове вікно Формат рисунка дозволяє задати різні способи обтікання 

рисунка текстом 

 

4. Клацніть на відповідному зображенні в групі Wrapping style 

(Обтікання), наприклад навколо рамки, по контуру або за текстом. Різні 

способи обтікання представлені різними значками, за зовнішнім виглядом 

яких можна легко визначити, до чого приведе застосування того або іншого 

варіанту обтікання. 

5. Клацніть на кнопці ОК. 

Клацнувши на кнопці Advanced (Додатково) після виконання п. 4, ви 

зможете задати точну відстань між текстом і рамкою рисунка: 

 

Переміщення рисункыв в документі 
Оскільки Word не завжди відображає рисунки там, де їм слід бути, ви 

завжди можете самостійно змінити місцерозташування с в документі. Щоб 

перемістити рисунок, виконайте наступне. 

1. Клацніть на рисунку, який необхідно перемістити. Навколо 

виділеного рисунка з’являться маркери. 
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2. Натисніть кнопку миші і перемістіть мишу. При перемешенії миші в 

тексті з’явиться сіра вертикальна лінія, вказуюча на місцерозташування в 

документі, в якому Word перемістить зображення після того, як ви відпустите 

кнопку миші. 

3. Перетягуйте покажчик миші до тих пір, поки рисунок не опиниться в 

потрібному місці, після чого відпустите кнопку миші. При переміщенні 

рисунка на велику відстань, наприклад з першої сторінки на сторінку 230, 

вам буде набагато простіше клацнути на рисунку, натиснути комбінацію 

клавіш <Ctrl+X>, клацнути в потрібному місці документа, після чого 

натиснути комбінацію клавіш <Ctrl+V>. 

 

Зміна розмірів рисунка в документі 
Якщо ви дійшли висновку, що зображення дуже велике або мало, 

виконайте наступні дії для зміни його розмірів. 

1. Клацніть на рисунку, розмір якого необхідно змінити. Навколо 

виділеного рисунка з’являться маркери. 

2. Підведіть покажчик миші до маркера, після чого натисніть кнопку 

миші і перемістіть мишу. 

При переміщенні миші в Word відобразить штрих-пунктірную лінію, за 

допомогою якої відображаються нові розміри зображення. 

3. Перетягуйте покажчик миші до тих пір, поки рисунок не прийме 

необхідні розміри, після чого відпустите кнопку миші. 

 

Видалення рисунка з документа 
Якщо ви дійшли висновку, що певний рисунок в документі вам більше 

не потрібен, видаліть його, виконавши наступні дії. 

1. Клацніть на рисунку, який необхідно видалити. Навколо виділеного 

рисунка з’являться маркери. 

2. Натисніть клавішу <Delete>. Word видалить виділений рисунок. 
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Лекція 4 

ОБРОБКА ТЕКСТІВ РЕДАКТОРОМ MS WORD 

 

1. Оформлення таблиць у MS Word 2003 

2. Попередній перегляд та друк документа 

 

1. Оформлення таблиць у MS Word 2003 

Таблиці дозволяють організувати інформацію у вигляді рядків і 

стовпців, що вельми зручно для представлення даних. У таблиці заносяться 

факти і цифри, на які читач може не звернути увагу в тексті, але які дуже 

наочно представляються в таблицях. 

Перш ніж почати роботу з таблицями, необхідно мати деякі уявлення 

про рядки і стовпці. 

– Рядки відображають інформацію по горизонталі. 

– Стовпці відображають інформацію по вертикалі. 

– Осередок – це клітка, утворена на місці перетину рядка і стовпця. 

Word надає три різні способи створення таблиці в документі. 

– Створення таблиці в документі за допомогою миші. 

– Визначення розмірів таблиці шляхом завдання кількості стовпців і 

рядків. 

– Визначення розмірів таблиці за допомогою миші і випадних меню. 

 

Створення таблиці за допомогою миші 

Якщо ви хочете швидко створити таблицю, намалюйте її контури за 

допомогою миші. Надалі ви зможете легко змінити її розміри. Щоб створити 

таблицю за допомогою миші, виконайте наступне. 

1. Виберіть команду Tabled→Draw Table (Таблица→Нарнсовать 

таблицю). З’явиться панель інструментів Tables and Borders (Таблиці і межі), 

а покажчик миші прийме вид олівця. 

2. Підведіть покажчик миші до того місця документа, в якому необхідно 

вставити таблицю. 

3. Утримуючи натиснутою ліву кнопку миші, намалюйте рамку таблиці 

необхідного розміру (рис. 7). 
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4. Відпустіть ліву кнопку миші. Word відобразить межі таблиці, 

намальовані суцільними лініями. 

5. Перетягніть покажчик миші всередину таблиці, щоб намалювати її 

стовпці і рядки. Ви можете малювати лінії не тільки по горизонталі і 

вертикалі, але і по діагоналі. 

Повторюйте ці дії необхідна кількість раз. 

 

 

Рисунок 7 – Створення таблиці за допомогою миші 

 

В тому випадку, якщо ви допустили помилку, клацніть на кнопці Eraser 

(Гумка) панелі інструментів Tables and Borders (Таблиці і межі), після чого 

клацніть на лінії, яку необхідно видалити. Потім клацніть на кнопці Draw 

Table (Намалювати таблицю) і продовжуйте малювання таблиці. 

 

Панель інструментів Таблиці та границі 

Ластик 

Накресоити таблицю 
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6. Натисніть клавішу <Esc>, як тільки закінчите малювання таблиці. 

Покажчик миші прийме вид звичайного курсора. Тепер ви можете вводити 

текст в елементах тільки що створеної таблиці. 

7. Клацніть на кнопці закриття панелі інструментів Tables and Borders 

(Таблиці і межі). 

 

Визначення параметрів таблиці за допомогою меню Таблиця 
Якщо ви хочете створити таблицю повільнішим шляхом, який дозволяє 

ретельніше управляти видом таблиці, використовуйте меню Word, що 

розкривається. 

1. Виберіть команду Tabled→Іnsert→Table (Таблиця→Додати→ 

Таблиця). З’явиться діалогове вікно Table Insert (Вставка таблиці), показане 

на рис. 8. 

2. Введіть потрібне число стовпців в поле Number of Columns (Число 

стовпців). 

3. Введіть потрібне число рядків в поле Number of Roes (Число рядків). 

4. У групі AutoFit Behavior (Автопідбір ширини стовпців) виберіть один 

з трьох перемикачів. 

• Fixed column width (Постійна). Ви можете вибрати значення 

Auto (Авто), а це означає, що ширина стовпця залежатиме від тексту, 

поміщеного в стовпець. Інші значення цього параметра визначаються 

в сантиметрах. 

• AutoFit to contents (По вмісту). Ширина стовпця залежатиме 

від щонайдовшого рядка, поміщеного в стовпець. 

• AutoFit to window (По ширині вікна). Ширина таблиці 

встановлюється на підставі ширини вікна, в якому відображається 

таблиця. 

5. Клацніть на кнопці AutoFormat (Автоформат). З’явиться діалогове 

вікно Table AutoFormat (Автоформат таблиці). 

6. У списку Table Styles (Формати) клацніть на одному з форматів 

таблиці (наприклад, Simple 1 (Простій 1) або Classic 3 (Класичний 3)) і 

спробуйте поекспериментувати з різними параметрами, доступними в цьому 

діалоговому вікні. У вікні Preview (Зразок) буде показаний зразок таблиці, 
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створеної з використанням вибраного формату. При установці якого-небудь 

додаткового прапорця в групі Apply Special formats to (Змінити оформлення) 

у вікні Preview (Зразок) будуть відображені всі зміни, пов’язані з даним 

прапорцем. 

7. Після вибору формату таблиці і пов’язаних з ним параметрів клацніть 

на кнопці ОК. Знову з’явиться діалогове вікно Table Insert (Вставка таблиці) 

(див. рис. 8). 

8. Клацніть на кнопці ОК. 

 

 
 

Рисунок 8 – Діалогове вікно Вставка таблиці 

 

Перетворення тексту в таблицю 
Якщо у вас є фрагмент тексту, розділеного комами, символами абзацу 

або табуляції, його можна легко перетворити на добре оформлену таблицю. 

Для перетворення тексту в таблицю виконаєте наступні дії. 

1. Виділіть текст, який необхідно перетворити в таблицю. 
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2. Виберіть команду Table→Convert→Text to Table (Таблиця→ 

Преобраэоватъ→Текст в таблицю). Відобразиться діалогове Convert Text to 

Table (Перетворити в таблицю) (рис. 9). Значення параметрів, представлені в 

справжньому діалоговому вікні, використовуються за умовчанням при соз- 

данії таблиці на основі виділеного фрагмента тексту при виконанні п. 1. 

Якщо необхідно змінити зовнішній вигляд таблиці, вкажіть максимальну 

кількість рядків і стовпців і форматування, клацнувши на кнопці AutoFormat 

(Автоформат). Внісши всі необхідні зміни, переходьте до п. 3. 

3. Клацніть на кнопці ОК. Word перетворить виділений текст в таблицю. 

Залежно від тексту, який ви виділили, таблиця може виглядати бездоганно, а 

може і містити текст, безладно розподілений між декількома осередками, 

тому вам доведеться додатково попрацювати над зовнішнім виглядом 

таблиці. 
 

 

 

Рисунок 9 – В діалоговому вікні Перетворити в таблицю можна задати кількість 

рядків і столцов в ьабліце 
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Введення і редагування даних таблиці 

Порожня таблиця не принесе вам ніякої користі, тому, очевидно, в неї 

треба занести якісь дані. Щоб ввести дані в таблицю або відредагувати їх, 

клацніть в осередку з даними і використовуйте звичайні клавіші на 

клавіатурі, щоб набирати і редагувати. 

Переміщатися по таблиці можна таким чином. 

Натисніть клавішу <Таb>, щоб перемістити курсор на один осередок 

управо в тій же самому рядку. 

Натисніть комбінацію клавіш <Shift+Tab>, щоб повернутися назад 

(вліво) в тому ж рядку. 

Використовуйте клавіші із стрілками <↑> і <↓>, щоб переходити з рядка 

на рядок. 

Видалення таблиці 
Word дозволяє видалити таблицю двома способами. 

1. Видалити всю таблицю разом з її вмістом 

2. Видалити тільки вміст таблиці (залишивши порожні осередки і 

формат таблиці незайманими). 

Щоб видалити тільки вміст таблиці, а не саму таблицю, виконайте 

наступне. 
1. Клацніть в будь-якому місці таблиці. 

2. Виберіть команду Table→Select→Table (Таблиця→Виділити→ 

Таблиця). Word виділить вибрану таблицю. 

3. Натисніть клавішу <Delete>. 

Щоб видалити всю таблицю (включаючи її вміст), виконайте 

наступні дії. 
1. Клацніть в будь-якому місці таблиці, яку треба видалити. 

2. Виберіть команду Table→Delete→Table (Таблица→Удалнть→ 

Таблица). Word видалить вибрану таблицю. 

Якщо ви помилково видалили всю таблицю або дані, що все містяться в 

ній, натисніть комбінацію клавіш <Ctrl+Z>, щоб повернути таблицю або дані 

в документ. 
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Додавання або видалення рядків, стовпців і осередків 
Після створення таблиці вам може прийти в голову думка варіювати її 

розміри, додаючи або видаляючи рядки і стовпці. 

Щоб видалити рядок або стовпець, виконайте наступне. 

1. Помістіть курсор в той рядок або в той стовпець, який ви хочете 

видалити. Можна використовувати як клавіші із стрілками на клавіатурі, так і 

миша. 

2. Виберіть команду Table^DeleteORows (Таблицас>Удалить>Строки) 

(або Columns (Стовпці)). 

Щоб видалити осередок (яка псує зовнішній вигляд таблиці), виконайте 

наступне. 

1. Помістіть курсор в той осередок, який ви хочете видалити. 

Можна використовувати як клавіші із стрілками на клавіатурі, так і 

миша. 

 2. Виберіть команду Таble→Deleted Cells (Таблиця→Видалити 

осередки). З’явиться діалогове вікно Delete Cells (Видалення осередків). 

3. Встановіть необхідний перемикач (наприклад, із зрушенням вліво) і 

клацніть на кнопці ОК. 

 

Щоб додати рядок або стовпець, виконайте наступні дії. 
1. Помістіть курсор в будь-який рядок або стовпець. 

2. Виберіть команду Table→lnsert→Cotumns to the Left 

(Таблиця→Додати→Стовпці зліва) (Columns to the Right (Стовпці справа), 

Rows Above (Рядки вищі) або Rows Below (Рядки нижчі)). 

 

Щоб додати осередок, виконайте наступне. 
1. Помістіть курсор в той осередок, який ви хочете видалити. 

2. Виберіть команду TableOlnsert→Cells (Таблиця→Додати→Осередки). 

З’явиться діалогове вікно Insert Cells (Додавання осередків). 

3. Встановіть необхідний перемикач (наприклад, із зрушенням управо) і 

клацніть на кнопці ОК. 
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Зміна розмірів рядків і стовпців таблиці 
Звичайно Word встановлює однакову ширину для всіх стовпців і 

однакову висоту для всіх рядків. Проте, якщо необхідно зробити деякі рядки 

або стовпці іншого розміру, Word надає можливість змінювати їх розміри, 

причому декількома способами: 

1. задаючи точні розміри певних осередків; 

2. змінюючи розміри осередків за допомогою миші. 

 

Простий спосіб зміни висоти рядка або ширини стовпця 
Якщо ви хочете змінити висоту рядки або ширину стовпця, виконайте 

наступні дії. 

1. Виберіть команду View→Print Layout (Вигляд→Розмітка сторінки) 

або клацніть на кнопці Print Layout View (Режим розмітки) в нижньому 

лівому кутку екрану. Word відобразить вертикальну лінійку зліва від 

сторінки і горизонтальну лінійку – вгорі. 

2. Клацніть в таблиці, яку вирішили змінити. Відобразяться маркери 

настройки рядків і стовпців таблиці (рис. 10). 

3. Підведіть курсор до одного з маркерів Adjust Table Row (Висота рядка 

таблиці) (сірі прямокутники) на вертикальній лінійці або Adjust Table Column 

(Переміщення стовпця таблиці) (сірі квадратні маркери) на горизонтальній 

лінійці. 

4. Натисніть кнопку миші і перетягуйте маркер вгору або вниз. Word 

відобразить пунктирну лінію, яка показує, якою буде висота рядки або 

ширина стовпця після того, як ви відпустите кнопку миші. 

5. Відпустіть кнопку миші, коли отримаєте необхідний результат.  
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Рисунок 10 – Для зміни розмірів рядків і стовпців можна використовувати відповідні 

маркери 

 

Введення точного значення висоти рядка або ширини стовпця 
Щоб задати точне значення висоти рядка або ширини стовпця, 

виконайте наступне. 

1. Клацніть в рядку або стовпці, які треба змінити. 

2. Виберіть команду Table→Table Properties (Таблиця→Свойства 

таблиці). З’явиться діалогове вікно Table Properties (Властивості таблиці) 

(рис. 11). 

3. Перейдіть на вкладку Row (Рядок) або Column (Стовпець). З’явиться 

вкладка Row (Рядок) або Column (Стовпець) діалогового вікна Table 

Properties (Властивості таблиці). 

4. Встановіть прапорець Specify height (Висота) або Preferred Width 

(Ширина) в групі Size (Розмір), щоб задати значення висоти рядка або 

ширини стовпця, наприклад 0,5 см. 

Маркери зміни 

висоти строк 

Маркери зміни 

ширини стовпця 
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5. Клацніть в полі режим групи Size (Розмір) і виберіть один з варіантів - 

At Least (Мінімум) або Exactly (Точно) (при настройці ширини стовпця 

виберіть варіант Centimeters (Сантиметри) або Percent (Відсоток)). 

Якщо ви виберете варіант At Least (Мінімум), висота рядків ніколи не 

буде менше вказаного значення, але може бути більше за це значення (що 

залежить від кількості тексту, введеного в рядку). Якщо вам необхідно, щоб 

всі рядки були однієї висоти, виберіть варіант Exactly (Точно). 

Вибравши варіант вимірювання ширини стовпця в сантиметрах, ви 

зможете задати точне значення ширини стовпця. Якщо ж вас більше цікавить 

не ширина стовпця, а зовнішній вигляд таблиці, незалежно від того, як ви 

змінюватимете її розміри, виберіть варіант Percent (Відсоток). 

6. Клацніть на кнопці ОК. 

 

 
Рисунок 11 – В діалоговому вікні Властивості таблиці можна вказати точні значення 

ширини стовпців або висоти рядків 

 

2. Попередній перегляд та друк документа 

He треба використовувати кожна слушна нагода, щоб роздруковувати 

пробний варіант свого документа і дивитися, чи добре вирівняні його поля. 
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Якщо вам не байдужа проблема виснаження природних ресурсів, боріться 

проти даремного друку і використовуйте такий корисний засіб Word, як 

попередній перегляд документа. 

 

Як працювати в режимі попереднього перегляду 
Режим попереднього перегляду дозволяє побачити документ в точності 

таким, яким він буде на папері. За допомогою цього засобу можна побачити, 

чи добре вирівняні поля і чи розставлені номери сторінок так, як ви цього 

хочете. 

Щоб перейти в режим попереднього перегляду, виконайте наступні дії. 

1. Виберіть команду File^Print Preview (Файл→Попередній перегляд). 

Word відобразить документ у вигляді друкарського аркуша, і курсор прийме 

вид збільшувального скла (рис. 12). 

2. Перемішайте курсор миші (у вигляді збільшувального скла) по 

документу і клацніть мишею, щоб побачити документ у натуральну 

величину. 

3. Клацніть на кнопці Close (Закрити), щоб вийти з режиму 

попереднього перегляду. 

 

Завдання параметрів сторінки 
Перш ніж виводити документи Word на друк, вам слід задати розмір 

паперу і величину полів. Щоб це зробити, виконайте наступне. 

1. Виберіть команду File→Page Setup (Файл→Параметри сторінки). 

З’явиться діалогове вікно Page Setup (Параметри сторінки). 

2. Перейдіть на вкладку Margins (Поля), після чого клацніть в текстових 

полях Тори (Верхнє), Bottom (Нижнє), Left (Ліве) і Right (Праве), щоб задати 

значення відповідних полів документа. З’явиться вкладка Margins (Поля) 

діалогового вікна Page Setup (Параметри сторінки) (рис. 13). 

3. Перейдіть на вкладку Paper (Розмір паперу), після чого клацніть в 

текстовому полі Paper Size (Розмір паперу) і встановіть необхідний розмір 

паперу (такий як Legal або А4). Можна також задати довільні висоту і 

ширину сторінок. 
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Рисунок 12 – Документ, відображений в режимі попереднього перегляду 

 

4. Клацніть в полі First Page (Перша сторінка) і Other Pages (Решта 

сторінок), щоб вказати джерело паперу, який використовуватиметься при 

друці. 

5. Перейдіть на вкладку Layout (Джерело паперу). На вкладці Layout 

(Джерело паперу) ви можете визначити, чи повинні розрізнятися 

колонтитули на парних і непарних сторінках і чи повинні вони відображатися 

на першій сторінці. 

6. Клацніть на кнопці ОК. 

Провівши таку складну підготовчу роботу, сміливо приступайте до 

друку документів Word. 
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Рисунок 13 – В діалогом вікні Параметри сторінки ви зможете задати величини полів і 

розмір паперу 

 

Друк документа 
Щоб вивести документ Word на друк, виконайте наступне. 

1. Виберіть команду File→Print (Файл→Печать) або натисніть 

комбінацію клавіш <CtrI+P>. З’явиться діалогове вікно Print (Друк) (рис. 14). 

2. Клацніть в полі Name (ім’я) і виберіть необхідний принтер. 

3. У групі Page range (Сторінки) встановите перемикач, що визначає, які 

сторінки будуть виведені на друк, наприклад все або поточна. Якщо ви 

вибрали перемикач Pages (Номери), то зможете вибірково вказати, які номери 

сторінок повинні бути надруковані, наприклад 1, 3 або 5-12. 

4. Клацніть в полі Number of copies (Число копій) групи Copies (Копії) і 

вкажіть необхідну кількість копій. 
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5. Клацніть в списку Print (Включити) і вкажіть, які сторінки необхідно 

друкувати, наприклад Odd pages (Непарні сторінки) або Even pages (Парні 

сторінки). 

6. Клацніть на кнопці ОК. 

 

 
Рисунок 14 – У діалоговому вікні Друк можна задати параметри друку документів 

 

Коли клацнути на кнопці Print (Друк) (значок у вигляді принтера) 

стандартної панелі інструментів, Word негайно почне друкувати ваш 

документ, минувши діалогове вікно Print (Друк). Якщо необхідно 

надрукувати тільки деякі сторінки або декілька копій, виберіть команду Print 

(Друк) з меню File (Файл) або натисніть комбінацію клавіш <CtrI+P>. 
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ПИТАННЯ ДЛЯ САМОСТІЙНОЇ ПІДГОТОВКИ СТУДЕНТА ДО 

МОДУЛЬНОГО КОНТРОЛЮ ПО MS WORD 2003 

 

1. Послідовність символів, слів і пропозицій, побудована відповідно до 

законів мови – це ... 

2. Інформаційне повідомлення в паперовій, звуковій або електронній 

формі, оформлене за певними правилами, завірене у встановленому порядку 

– це ... 

3. Закодоване й передане в інформаційну систему електронне 

повідомлення, усі реквізити якого завірені й оформлені відповідно до 

нормативних вимог – це ... 

4. Система створення, передачі, приймання й архівування документів, 

контролю над їхнім виконанням і захисту від несанкціонованого доступу – це 

... 

5. За замовчуванням Word визначає роботу з аркушем паперу, що 

мають книжкову орієнтацію й формат А4 розміром ... мм.  

6. Діловодство визначає поля сторінки документа в Word (ліворуч, 

праворуч, зверху, знизу) рівні ... мм. 

7. Завдання параметрів в Word для сторінки з текстом по жирності, 

курсиві, підкресленні й по типу використовуваних шрифтів – усе це є … 

8. Більша заголовна буква слова в абзаці, верхній край якої вирівняний 

по верхньому краю абзацу, називається в Word … 

9. Набір команд, які автоматично виконуються в Word як одна команда, 

називається … 

10. Варіанти – одинарний, полуторний, подвійний, мінімум, точно, 

множник – характеризують в абзаці Word … 

11. Щоб в Word скопіювати виділений фрагмент тексту в буфер обміну 

потрібно нажати клавіші … 

12. Щоб в Word вирізати виділений фрагмент тексту в буфер обміну 

потрібно нажати клавіші … 

13. Щоб в Word вставити з буфера обміну в документ фрагмент тексту 

або будь–який наявний у цьому буфері об’єкт, потрібно нажати клавіші … 

14. Якщо, перебуваючи на смузі виділення в Word, клацнути мишкою 

один раз, то буде виділений( про, а) … 
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15. Якщо, перебуваючи на смузі виділення в Word, двічі клацнути 

мишкою, то буде виділений( про, а) … 

16. Якщо, перебуваючи на смузі виділення в Word, тричі клацнути 

мишкою, то буде виділений( про, а) … 

17. Якщо, перебуваючи на абзаці тексту конкретного документа в Word, 

двічі клацнути мишкою на якому–небудь слові, то буде виділений( про, а) … 

18. Для виділення в Word за допомогою клавіатури одному рядка 

тексту потрібно нажати клавіші … 

19. Для виділення в Word за допомогою клавіатури одного символу 

тексту потрібно нажати клавіші … 

20. Для виділення в Word за допомогою клавіатури одного слова тексту 

потрібно нажати клавіші … 

21. Для виділення в Word за допомогою клавіатури одного абзацу тексту 

( від його початку до кінця або навпаки від кінця до початку) потрібно 

нажати клавіші … 

22. Для виділення в Word за допомогою клавіатури частини рядка від 

курсору до початку поточного рядка тексту потрібно нажати клавіші … 

23. Для виділення в Word за допомогою клавіатури частини рядка від 

курсору до кінця поточного рядка тексту потрібно нажати … 

24. Для виділення в Word за допомогою клавіатури частини документа 

від курсору до початку документа потрібно нажати … 

25. Для виділення в Word за допомогою клавіатури частини документа 

від курсору до кінця документа потрібно нажати клавіші … 

26. Для створення в Word колонтитула з довільним розташуванням на 

сторінці (а не тільки зверху або знизу) можна використовувати приймання 

прив’язки колонтитула до … 

27. Параметри звичайного шаблону й стилю, базові макрокоманди Word 

зберігає у файлі з іменем … 

28. .doc – це розширення в імені файлів, створюваних програмою ... 
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Лекція 5 

РОБОТА З ЕЛЕКТРОННИМИ ТАБЛИЦЯМИ  MS EXCEL 

 

1. Терміни й визначення 

2. Електронна таблиця й модель гнізда  

 

Серед основних тем, розглянутих звичайно при вивченні програми 

роботи з електронними таблицями MS Excel 2003, представлені наступні 

[5, 6, 7]: 

 Технологія обробки інформації на основі електронних таблиць. 

 Програма MS Excel 2003 (призначення, версії, інтерфейс, меню, 

панель завдань і панелі інструментів, сервісні можливості, робота з її 

файлами й із системою допомоги).  

 Основні прийоми роботи з електронними таблицями (створення й 

настроювання робочої книги, оформлення аркушів з таблицями, модель 

гнізда, типи даних, форматування рядків, стовпців, гнізд, введення даних і 

приймання їх редагування, елементарні обчислення).  

 Обчислення в MS Excel 2003 (створення й редагування формул, 

адресація гнізд, категорії функцій, правила роботи з формулами й функціями, 

найпростіші математичні й статистичні функції, пошук і виправлення 

помилок в обчисленнях). 

 Сортування й фільтрація даних. Пошук потрібної інформації. Робота 

з діапазонами гнізд. Спеціальна вставка й автозаповнення. 

 Діаграми MS Excel 2003 (типи й майстер діаграм, оформлення 

елементів і областей діаграм). 

 Друк таблиць (параметри сторінки, колонтитули, нумерація сторінок, 

попередній перегляд, діапазони печатки). 

 Зв’язок MS Excel 2003 з іншими офісними пакетами (з MS Word 2003 

і з MS Access 2003). XML в MS Excel 2003. 

 Приймання й приклади практичної роботи з даними в електронних 

таблицях (наприклад, обробка даних соціологічного дослідження й 

комп’ютерного тестування). 
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1. Терміни й визначення 

Робоча книга – документ Excel, що полягає з набору робочих аркушів, 

кожний з яких має табличну структуру. 

Робочий аркуш – це одна сторінка робочої книги Excel, що полягає з 

рядків і стовпців. Перетинання рядків і стовпців утворюються гнізда таблиці. 

Адреса гнізда – складається з номера (букви) стовпця й номера рядка. 

Діапазон гнізд – адреси гнізд у вигляді ряду, що вказують обраної 

функції дані для розрахунків. 

Посилання – це адреси гнізд, що використовуються у формулах. 

Посилання бувають відносні й абсолютні. 

Діаграма – графічна вистава даних в електронній таблиці. 

Гістограма – діаграма, що складається з горизонтальних або 

вертикальних смуг, ширина й висота яких відповідають деяким значенням.  

Автозаповнення – автоматичне заповнення гнізд формулами або 

числами.  

Копіювання – в Excel це операції копіювання вмісту гнізда, її формату, 

формули, результату, примітки (тобто копіювання всіх елементів моделі 

гнізда цілком або по окремих, перерахованим елементам).  

Буфер обміну – це область пам’яті комп’ютера, що використовується 

для тимчасового зберігання об’єкта, що копіюється (фрагмент документа, 

рисунок, формула і т.д.) і наступної вставки цього об’єкта в інші документи 

або в той же документ в іншім місці. Об’єкт у буфері обміну зберігається 

доти, поки не буде замінений іншим об’єктом або до закінчення роботи з 

конкретним додатком або з ОС Windows. 

Формула – основа обчислень у таблицях програми Excel. Кожна 

формула може містити числові константи, посилання на гнізда й функції 

Excel, з’єднані знаками математичних операцій. 

Формула – арифметичне, логічне й інше ( із припустимих) дія над 

умістом гнізд електронної таблиці. Формула починається зі знака “=” і 

містить у собі адреси гнізд, знаки арифметичної й логічної відповідності, 

стандартні функції з аргументами, дужки. 

Функція – це запрограмована формула, що дозволяє проводити 

послідовності, що часто зустрічаються, обчислень (стандартні обчислення). 
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Функція має ім’я й, як правило, аргументи. В MS Excel 2003 є великий набір 

різних стандартних функцій ( близько 330 штук). 

 

2. Електронна таблиця й модель гнізда 

Електронна таблиця (ЕТ)  це інтерактивна система обробки дан, що 

представляє собою прямокутну таблицю, гнізда якої можуть містити числа, 

рядка й формули, що задають залежність значення гнізда від інших гнізд. 

При цьому зміна вмісту гнізда приводить до зміни вмісту залежних від неї 

гнізд із негайним відображенням на екрані дисплея. ЕТ призначені для 

зберігання й обробки інформації, представленої в табличній формі. За 

допомогою ЕТ можна виконувати різні економічні, бухгалтерські й 

інженерні розрахунки, будувати різного роду діаграми, проводити 

економічний аналіз, моделювати й оптимізувати різні ситуації і т.д. 

 

 
Рисунок 15 – Форматування гнізд 
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Модель гнізда в ЕТ має п’ять наступних рівнів. Зображення на екрані – 

це відформатовані значення – числа, текст, результат обчислення формул. 

Сховане форматування – це формати чисел (показані на рис. 15), тип шрифту, 

вид рамки, рівень захисту гнізда. Формула, яка складається із чисел, значків і 

математичних виражень. Ім’я гнізда, що однозначно ідентифікує кожне 

конкретне гніздо. Коментар (примітка) – це текст, який через додаткове вікно 

зв’язується із гніздом. При цьому в правому верхньому куті гнізда 

показується червона крапка. 
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Лекція 6 

РОБОТА З ЕЛЕКТРОННИМИ ТАБЛИЦЯМИ MS EXCEL 

 

1. Інтерфейс програми MS Excel 2003 

2. Операції із гніздами, посилання  

 

1. Інтерфейс програми MS Excel 2003 

Програма MS Excel 2000/2003 є найбільше розповсюдженою у світі для 

роботи з ЕТ на персональних комп’ютерах. Вона має всі найсучасніші 

компоненти й режими, працює як самостійна програма або в складі пакета 

MS Office 2003. Файли з ЕТ мають розширення xls. 

 

Інтерфейс програми MS Excel 2003 показаний на рис. 16. Елементами 

інтерфейсу є: 

 Рядок заголовка. 

 Рядок меню. 

 Панель інструментів. 

 Панель форматування. 

 Поле імені гнізда, рядок формул. 

 Заголовок стовпця й заголовок рядка. 

 Ярлички аркушів.  

 Смуги прокручування й рядок стану. 

 

Файл MS Excel 2003 називається робочою книгою. Вона складається з 

аркушів, імена яких (Аркуш1, Аркуш2, …)  виведені на ярликах у нижній 

частині вікна робочої книги. Аркуш гнізд це 256 стовпців і 16384 рядка. 

Заголовок стовпця позначається буквами A, B, C ... Z, AA, AB, ... AZ ...,  а 

заголовок рядка нумерується 1, 2, 3 і т.д. Клацаючи по ярликах, можна 

переходити від аркуша до аркуша усередині робочої книги. 
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Рисунок 16 – Інтерфейс програми MS Excel 2003 

 

Є два режими перегляду для роботи (меню Вид): 

 Звичайний – найбільш зручний для виконання більшості операцій. 

 Розмітка сторінок – зручний для остаточного форматування таблиці 

перед печаткою. Границі між сторінками в цьому режимі відображаються 

синіми пунктирними лініями. Границі таблиці – суцільний синьої лінією. 

Настроювання вмісту й виду панелей інструментів MS Excel 2003 

виконується через меню. Можна зробити кнопки кольоровими, більшими, з 

підказками.  

 

2. Операції із гніздами, посилання 

В ЕТ можна вставляти рядка й стовпці (у т.ч. і з форматуванням), кілька 

стовпців або рядків. Можна видаляти рядки й стовпці цілком. Можна їх 

копіювати, вирізати й вставляти, використовуючи, наприклад, типові 

комбінації клавіш:  

CTRL+INS  скопіювати об’єкт у буфер. 

SHIFT+DEL  вирізати об’єкт у буфер. 

SHIFT+INS  вставити об’єкт із буфера в таблицю. 
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Можна пересуватися по робочому аркушу (мишка або клавіші 

керування курсором), виправляти помилки введення, змінювати вміст гнізда, 

видаляти вміст гнізда і т.д.  

 

Виділення елементів таблиці. Одна із гнізд таблиці завжди є активною. 

Активне гніздо виділяється рамкою. Щоб зробити гніздо активної, необхідно 

клавішами керування курсором підвести рамку до цього гнізда або клацнути 

в ній мишею. Для виділення декількох суміжних гнізд необхідно встановити 

покажчик миші в одну із гнізд, нажати ліву кнопку миші й, не відпускаючи її, 

розтягти виділення на всю область. Для виділення декількох несуміжних 

груп гнізд слід виділити одну групу, нажати клавішу Ctrl і, не відпускаючи її, 

виділити інші гнізда. Щоб виділити цілий стовпець або рядок таблиці, 

необхідно клацнути мишею на його імені. Для виділення декількох стовпців 

або рядків слід клацнути на імені першого стовпця або рядка й розтягти 

виділення на всю область. Для виділення декількох аркушів необхідно 

нажати клавішу Ctrl і, не відпускаючи її, клацати на ярликах аркушів. 

Із гніздом ЕТ можна виконувати наступні основні операції – уведення 

тексту й чисел, виправлення помилок уведення, зміна вмісту, видалення 

вмісту. У гніздо можна вводити текст і числа (виконуючи підтвердження 

введення трьома способами – Enter, клацання мишкою по іншім гнізду, 

покинути гніздо стрілками). Гнізда ЕТ можна форматувати ( усі разом і 

кожну окремо (масно, шрифт, розмір, вирівнювання тексту, вибір кольору 

тла й чисел на тлі, обрамлення для виділених гнізд). 

По закінченню роботи із гніздами ЕТ потрібно зберегти у файлі. Це 

виконується через меню (файл/зберегти або зберегти як). Перед печаткою 

файлів з ЕТ спочатку потрібно виставити параметри сторінки  її орієнтація, 

формат аркуша, поля колонтитули і т.д. Безпосередньо перед печаткою 

можна уточнити, що друкувати  виділений блок, усю таблицю або конкретні 

сторінки по зазначених номерах. У режимі попереднього перегляду можна 

побачити як реально будуть розташовані дані на папері. 

Права кнопка мишки над виділеним об’єктом ЕТ дає контекстно-

залежне меню (вирізати, копіювати, вставити, вилучити, очистити, 
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форматувати). Спеціальна вставка дозволить для об’єкта працювати на 

вибір  вставити всі або тільки формули, значення, формати, примітки. 

Найважливіший етап роботи з ЕТ  це оформлення аркушів. При 

цьому можна вибирати через меню (формат/гнізда) по закладках  формат 

чисел, вирівнювання, шрифт, розмір, вид, стиль, захист (див. рис 9). 

Рекомендується дотримувати наступних правил – не більш 2-х, 3-х типів і 2-х 

розмірів штифтів на 1 сторінці, не захоплюватися при призначенні стилів 

(масно, курсив, підкреслення) і при виборі кольору й візерунків, щоб не 

перевантажувати таблицю. 

Лінії роздягнула гнізд полегшать роботу з таблицею й вибираються 

через меню. Можна також у гніздах таблиці переглядати формули замість 

обчислених значень. Включати або виключати видимість смуг 

прокручування і  ярлички аркушів. Крім відзначеного на аркушах 

електронної таблиці вводяться для виділених об’єктів рамки. Регулюється 

висота рядків і ширина колонок, форматуються числа, виконується 

автоформатування таблиць по шаблонах, може бути перевірена для текстів у 

гніздах орфографія. 

Кожне гніздо таблиці має адресу, яка складається з імені рядка й імені 

стовпця. Наприклад, якщо гніздо перебуває в стовпці F і рядку 7, то вона має 

адресу F7.  

Посиланням однозначно визначається гніздо або група гнізд аркуша, 

а також спрощується пошук значень або даних, використовуваних у 

формулі. Посилання на гнізда інших книг називаються зовнішніми 

посиланнями. Посилання на дані інших додатків називаються вилученими 

посиланнями. За замовчуванням в MS Excel 2003 використовуються 

посилання A1, у яких стовпці позначаються буквами від A до Z (256 

стовпців максимально), а рядка числами – від 1 до 65536). Щоб указати 

посилання на гніздо, уведіть букву заголовка стовпця, а потім номер рядка. 

Наприклад, D50 є посиланням на гніздо, розташовану в перетинанні стовпця 

D з 50-й рядком.  

Щоб послатися на діапазон гнізд, уведіть посилання на верхній лівий 

кут діапазону, поставте двокрапку (:), а потім – посилання на правий нижній 

кут діапазону. 
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Щоб послатися на: Уведіть: 

Гніздо стовпця A і 10-й рядка A10 

Діапазон гнізд стовпця A з 10-й рядка по 20-у A10:A20 

Діапазон гнізд в 15-й рядку зі стовпця B по 

стовпець E 

B15:E15 

Усі гнізда в 5-й рядку 5:5 

Усі гнізда між 5-й і 10-й рядками включно 5:10 

Усі гнізда в стовпці H H:H 

Усі гнізда між стовпцями H і J включно H:J 

 

Можна скористатися стилем, у якому і стовпці, і рядки аркуша 

пронумеровані. Цей стиль, називаний R1C1, найбільш корисний при 

обчисленні позиції рядка й стовпця в макросах, а також при відображенні 

відносних посилань. У стилі R1C1, після букви «R» вказується номер рядка 

гнізда, після букви “C” – номер стовпця.  

Залежно від поставленого завдання можна використовувати відносні 

посилання, які посилаються на гнізда щодо позиції формули, або абсолютні 

посилання, які посилаються завжди на те самеу гніздо. Якщо необхідно, щоб 

посилання не змінювалися при копіюванні формули в інше гніздо, 

скористайтеся абсолютними посиланнями. Для створення абсолютного 

посилання на гніздо C1, поставте знак долара ($) перед тою частиною, яка не 

повинна змінюватися. Щоб створити абсолютне посилання на гніздо C1, 

помістіть знак долара так, як показано в прикладі: =A5*$C$1 
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Лекція 7 

РОБОТА З ЕЛЕКТРОННИМИ ТАБЛИЦЯМИ  MS EXCEL 

 

1. Формули й функції 

 

1. Формули й функції 

Формулою називається вираз, відповідно до якого обчислюється 

значення гнізда. Формула є основним засобом для аналізу даних. За 

допомогою формул можна складати, множити й порівнювати дані, а також 

поєднувати значення. Формули можуть посилатися на гнізда поточного 

аркуша, аркушів тієї ж книги або інших книг. Саму формулу можна побачити 

в рядку введення, коли дана гніздо стане активним. 

В Excel використовуються оператори (додавання, иіднімання, 

множення, розподіл, зведення в ступінь, обчислення відсотків), знаки (рівно, 

менше, більше, менше або рівно, більше або рівно, не рівно), зв’язки 

(діапазон і об’єднання). Синтаксис формули – це порядок, у якім 

обчислюються значення. Послідовність виконання операторів у формулі 

(ієрархія) така – зв’язки, заперечення, відсотки, зведення в ступінь, крапкові 

обчислення, лінійні обчислення, текст, порівняння. 

Розрахунки починаються із вставки й редагування формул. 

Використовується така технологія. Виберіть гніздо для формули, наприклад, 

С8. Знак =. Клацання мишкою на С5, потім +, клацання на С7. Закінчення 

введення формули по клавіші Enter. Обчислення вмісту гнізда  у рядку 

формул це записи типу =С5+С6+С7 (тут знак рівності означає, що далі 

записана формула) або типу  =СУМ(С5:С7), що в обох випадках означає 

підсумовування вмісту гнізд із  діапазону. 

Функції (це запрограмовані формули, що дозволяють проводити 

послідовності обчислень, що часто зустрічаються) включаються або через 

піктограму “Суматор” або через “Інтеграл” і тоді запускається діалог з 

“Майстром функцій” (див. рис. 17 і 18). 

 



 

53 

 
Рисунок 17 – Майстер функцій MS Excel 2003 (крок 1 з 2) 

 

Функції задаються за допомогою формул, які виконують обчислення 

по заданих величинах, називаних аргументами, і в зазначеному порядку. 

Список аргументів може складатися із чисел, тексту, логічних величин, 

масивів, значень помилок або посилань. 

Функції можуть бути вкладеними, якщо вони використовуються як 

аргументи в інших функціях. У такому випадку вона повинна повертати 

аргументу значення того ж типу. У формулах можна використовувати до 

семи рівнів вкладення функцій. Коли “функція Б” є аргументом “функції 

А”, обто “функція Б” важається другим рівнем вкладення. Якщо в “функції 

Б” утримується в якості аргументу “функція В”, то “функція В” буде 

вважатися третім рівнем вкладення функцій.  
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Рисунок 18 – Майстер функцій MS Excel 2003 (крок 2 з 2) 

 

Бібліотека функцій програми MS Excel 2003 нараховує близько 330 

різних функцій, об’єднаних у наступні тематичні групи: 

 Функції баз даних. 

 Функції дати й часу. 

 Інженерні функції. 

 Фінансові функції. 

 Інформаційні функції. 

 Логічні функції. 

 Функції посилання й автопідстановки. 

 Арифметичні й тригонометричні функції 

 Статистичні функції. 

 Текстові функції. 

 



 

55 

Лекція 8 

РОБОТА З ЕЛЕКТРОННИМИ ТАБЛИЦЯМИ  MS EXCEL 

 

1. Діаграми 

 

1. Діаграми 

Для створення діаграм використовується “Майстер діаграм”. Крок 1 з 4-

х, що дозволяє вибрати тип діаграм, показаний на рис. 19.  

 

 
Рисунок 19 – Майстер діаграм MS Excel 2003 (крок 1 з 4) 

 

Основні типи діаграм наступні. 

Гістограма показує зміну даних за певний період часу й ілюструє 

співвідношення окремих значень даних. Категорії розташовуються по 
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горизонталі, а значення по вертикалі. У такий спосіб приділяється більша 

увага змінам у часі. Гістограма з нагромадженням демонструє внесок 

окремих елементів у загальну суму. У тривимірній гістограмі порівняння 

даних проводиться по двом осям.  

Лінійна діаграма відбиває співвідношення окремих компонентів. 

Категорії розташовані по горизонталі, а значення по вертикалі. У такий 

спосіб приділяється більша увага зіставленню значень і менше – змінам у 

часі. Лінійна діаграма з нагромадженням показує внесок окремих елементів у 

загальну суму. 

Графік відбиває тенденції зміни даних за рівні проміжки часу. 

Кругова діаграма показує як абсолютну величину кожного елемента 

ряду даних, так і його внесок у загальну суму. На круговій діаграмі може 

бути представлений тільки один ряд даних. Таку діаграму рекомендується 

використовувати, коли необхідно підкреслити який-небудь значний елемент. 

Для полегшення роботи з маленькими частками діаграми в основній діаграмі 

їх можна об’єднати в один елемент, а потім розбити їх в окрему діаграму 

поруч із основний. 

Крапкова діаграма відображає взаємозв’язок між числовими 

значеннями в декількох рядах. 

Діаграма з областями підкреслює величину зміни протягом певного 

періоду часу, показуючи суму введених значень. Вона також відображає 

внесок окремих значень у загальну суму.  

Кільцева діаграма показує внесок кожного елемента в загальну суму, 

але на відміну від кругової діаграми вона може містити кілька рядів даних. 

Кожне кільце в кільцевій діаграмі представляє окремий ряд даних. 

У пелюстковій діаграмі кожна категорія має власну вісь координат, що 

виходить із початку координат. Лініями з’єднуються всі значення з певної 

серії. Пелюсткова діаграма дозволяє зрівняти загальні значення з декількох 

наборів даних.  

Поверхнева діаграма використовується для пошуку найкращої 

комбінації двох наборів даних. Як на топографічній карті, області з одним 

значенням виділяються однаковим візерунком і кольором.  

Пузирькова діаграма є різновидом крапкової діаграми. Розмір маркера 

даних указує значення третьої змінної. При підготовці даних слід 
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розташувати в одному рядку або стовпці всі значення змінної x, а відповідні 

значення y – у суміжних рядках або стовпцях.  

Біржова діаграма часто використовується для демонстрації цін на акції. 

Цей тип діаграми також може бути використаний для наукових даних. 

Біржова діаграма для наборів із трьох і п’яти значень може мати дві осі: одна 

для стовпців, що представляють інтервал коливань, інша для цін на акції. 

На рис. 20 показаний екран майстра діаграм, що дозволяє визначити 

наступні основні елементи оформлення діаграм. 

 

 
Рисунок 20 – Майстер діаграм програми MS Excel 2003 (крок 3 з 4) 

 

Назва діаграми – описовий текст, автоматично пов’язаний з віссю або 

розташований по центру діаграми.  

Лінії сітки – лінії, які, будучи додані до діаграми, полегшують перегляд 

і аналіз даних. Лінії сітки відображаються паралельно осям від розподілів 

діаграми. 

Вісь – лінія, що часто обмежує з однієї сторони область побудови, і 

використовувана як основа вимірів для побудови даних на діаграмі. У 

більшості діаграм крапки даних відображаються по осі (y), яка звичайно є 
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вертикальною віссю, а категорії відображаються по осі (x), як правило 

горизонтальної. 

Підпис значення – підпис, що надає додаткові відомості про крапку 

даних, що відображає яке–небудь значення гнізда. Підписами даних можуть 

бути постачені як окремі крапки даних, так і весь ряд цілком. Залежно від 

типу діаграми підписи даних можуть відображати значення, назви рядів і 

категорій, частки або їх комбінації. 

Легенда – підпис, що визначає зафарбування або кольори крапок даних 

або категорій діаграми. 

Таблиця даних діаграми – утримуюча відображувані на діаграмі дані 

таблиця. Кожний рядок таблиці даних містить ряд даних. Таблиця даних 

звичайно пов’язана з віссю категорій і заміняє підписи осі категорій. 
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ПИТАННЯ ДЛЯ САМОСТІЙНОЇ ПІДГОТОВКИ СТУДЕНТА ДО 

МОДУЛЬНОГО КОНТРОЛЮ ПО MS EXCEL 2003 

 

1. Кожна нова книга в Excel за замовчуванням звичайно містить ... 

робочих аркуша(ів). Усього вона може мати до ... аркушів.  

2. Для чого головним чином в Excel використовуються команди меню 

“Виправлення”? 

3. Для чого головним чином в Excel використовуються команди меню 

“Сервіс”? 

4. Для чого головним чином в Excel служать команди меню “Формат”? 

5. Для чого головним чином в Excel служать команди меню “Файл”? 

6. Для чого головним чином в Excel використовуються команди меню 

“Вид”? 

7. Що мається на увазі під поняттям “Форматування документа Excel” ? 

8. Для чого в Excel використовується команда “Зберегти як”? 

9. Що в Excel розуміється під терміном “Імпорт файлів”? 

10. Що в Excel розуміється під терміном “Експорт файлів”? 

11. В електронній таблиці Excel виділена група гнізд ІЗ3:F6 Скільки 

гнізд входить у цю групу? 

12. Число, вирівнювання, шрифт, границя, вид і захист – це елементи 

форматування в Excel для … 

13. Висота, автопідбір висоти, сховати, відобразити – це елементи 

форматування в Excel для … 

14. Ширина, автопідбір ширини, сховати, відобразити, стандартна 

ширина – це елементи форматування в Excel для … 

15. Перейменувати, сховати, відобразити, подложка, колір ярличка – це 

елементи форматування в Excel для … 

16. В Excel формула в електронних таблицях не може включати … 

17. За допомогою формул в Excel проводяться обчислення. Формули, які 

вбудовані в бібліотеки й виконуючі конкретні операції, працюючи з 

аргументами, називаються … 

18. Посилання на гнізда з іншого робочого аркуша Excel реалізуються за 

рахунок уведення у формули ... перед іменем цих гнізд. 
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19. В Excel можна транспонувати таблиці (вставляти з буфера обміну 

рядка діапазону по стовпцях, а стовпці по рядках використовуючи операцію 

… 

20. В Excel можна вставляти з буфера обміну окремі атрибути гнізд 

(тільки їх значення або формат) використовуючи операцію … 

21. Легенда, лінії сітки й лінії тренда –це параметри, які можуть 

мінятися при роботі в Excel з … 

22. Діаграми начебто ширяючих брусків можна одержати в Excel, 

працюючи з типом … 

23. Діаграма в Excel, що полягає з горизонтальних або вертикальних 

смуг, ширина та висота яких відповідають деяким значенням – це … 

24. Щоб привернути увагу читачів до окремих частин діаграми 

(наприклад до незвичайної поведінки якого–-небудь графіка) в Excel 

рекомендується використовувати … 

25. В Excel можна створити верхній і нижній колонтитули. Для цього 

через пункт меню ... потрібно почати цю операцію.  

26. Прізвище “автора” (виконавця) електронної книги Excel можна 

вказати, використовуючи команду ... у меню “Файл” 

27. Скільки гнізд у блоці A3 : D5 електронної таблиці Excel? 

28. З якого знака починається завдання формули гнізда? 

29. Скільки може мати рядків електронна таблиця MS Excel? 

30. Скільки стовпців може містити електронна таблиця MS Excel? 

31. .xls – це розширення в імені файлів, створюваних програмою ... 
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